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1. INTENDED USE

The BD OneFlow™ PCST (Plasma Cell Screening Tube) is intended for 
flow-cytometric immunophenotyping of normal polyclonal and 
aberrant plasma cell populations in bone marrow as an aid in the 
diagnosis of hematological disorders. The BD OneFlow™ PCST tube is 
designed for use with a suitably equipped BD flow cytometer and 
software designated for in vitro diagnostic use.

2. SUMMARY AND EXPLANATION

Plasma cell disorders (PCD) are a group of diseases most often 
characterized as having a clonal (neoplastic) population of plasma cells 
in the bone marrow (BM).1 The cells may secrete a clonal 
immunoglobulin which can be detected in the circulation. These 
disorders comprise several distinct diseases, including multiple 
myeloma and monoclonal gammopathy of undetermined significance.

The EuroFlow™* Consortium designed multicolor antibody panels to 
fully characterize the cell populations in a patient specimen using 
immunophenotypic markers that are indicative of normal and 
abnormal cells.1 In addition to the optimized multicolor antibody 
panels, the EuroFlow protocol comprises standardized procedures for 
cytometer setup, determination of assay settings, sample preparation 
and staining, sample acquisition, and data analysis.2

The single-tube screening panels and multi-tube classification panels fit 
into the EuroFlow diagnostic algorithm for the identification and 
classification of hematological disorders. Each tube contains a set of 
backbone markers and a set of classification markers.1 Backbone 
markers are shared across a particular set of panels and are used to 
normalize the samples so that data files can be combined and analyzed 
as a single large data file. They are markers that identify distinct cell 

* The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property 
of the EuroFlow Consortium and cannot be reproduced or published without prior 
written permission from the EuroFlow coordinator (www.euroflow.org).

http://www.euroflow.org
http://www.euroflow.org
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populations in a particular cell lineage. Classification markers have 
been selected for their diagnostic utility in discriminating between cell 
types within a given lineage and in classifying the abnormal cell type in 
the sample.

3. PRINCIPLES OF THE PROCEDURE

Multiparameter flow cytometry is a sensitive and rapid tool for the 
qualitative and quantitative characterization of cell populations in a 
specimen. Cells are incubated with fluorochrome-conjugated 
antibodies which bind to their target molecules. The stained cells can 
then be analyzed on a single-cell basis. Multiparameter analysis of the 
data is used to identify the cell populations in the patient specimen and 
can lead to the identification of an aberrant clonal cell population.

The number of parameters used in flow cytometric 
immunophenotyping of hematological disorders has increased in recent 
years. BD OneFlow™ PCST contains a panel of fluorochrome-
conjugated antibodies that identify normal and aberrant populations of 
plasma cells. Analysis of the dot plots allows for the identification of 
normal and abnormal cell populations.

4. REAGENT 

Reagent Composition

BD OneFlow™ PCST consists of two single-use tubes containing 
fluorochrome-conjugated antibodies in an optimized dried 
formulation. BD OneFlow™ PCST (S) contains antibodies that 
recognize markers on the surface of cells, and BD OneFlow™ 
PCST (C) contains antibodies that recognize Igκ and Igλ in the 
cytoplasm of cells after fixing and permeabilizing them. See Table 1.
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The antibodies in the BD OneFlow™ PCST tube were chosen for their 
ability to identify and characterize plasma cells.

CD38, CD138, CD45, and CD19 are backbone markers used to 
identify plasma cells.

CD56 and β2-Microglobulin are classification markers used to identify 
aberrant plasma cell populations.

Anti-Kappa and Anti-Lambda are used to assess the clonality of the 
plasma cells.

CD19, Anti-Kappa, and Anti-Lambda are also used to identify and 
characterize mature B cells.

Table 1 BD OneFlow™ PCST antibody panel

Antibody Tube Fluorochrome Clone Isotype

CD38 S FITC HB73 IgG1, κ

CD56 S PE MY31 (Leu-19)4,5 IgG1, κ

β2-Microglobulin S PerCP-Cy™5.5a

a. Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and 
Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed for 
sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license to use 
this product and do not have one, return this material, unopened, to BD Biosciences, 2350 Qume Drive, San 
Jose, CA 95131, and any money paid for the material will be refunded.

TÜ996 IgM, κ

CD19 S PE-Cy™7a SJ25-C13,7 IgG1, κ

Anti-Kappa C APC TB28-28 IgG1, κ

Anti-Lambda C APC-H7 1-155-28 IgG1, κ

CD45 S V450b

b. BD Horizon™ V450, BD Horizon™ V500-C

2D1 (anti-HLe-1)9,10 IgG1, κ

CD138 S V500-Cb MI1511,12 IgG1, κ
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Refer to the article describing the EuroFlow antibody panels1 for a full 
description of the utility of the antibodies chosen for the 
BD OneFlow™ PCST tube.

Precautions

• The reagents contain 0.25 – <1% of 5-chloro-2-methyl-4-
isothiazolin-3-one and 2-methyl-4-isothiazolin-3-one (3:1) (CAS 
number 2682-20-4) and 0.1 – <0.25% of sodium azide (CAS 
number 26628-22-8). The reagents are classified as hazardous 
according to the Globally Harmonized System of Classification 
and Labelling of Chemicals (GHS). Go to regdocs.bd.com to 
download the Safety Data Sheet.

Warning

H317: May cause an allergic skin reaction.
H412: Harmful to aquatic life with long lasting effects.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of 
the workplace.
P280: Wear protective gloves/protective clothing/eye protection/
face protection.
P273: Avoid release to the environment.

Response P302+P352: IF ON SKIN: Wash with plenty of water/...
P333+P313: If skin irritation or rash occurs: Get medical advice/
attention.
P321: Specific treatment (see Safety Data Sheet).
P363: Wash contaminated clothing before reuse.

Disposal P501: Dispose of contents/container to an appropriate treatment 
and disposal facility in accordance with applicable laws and 
regulations, and product characteristics at time of disposal.

http://regdocs.bd.com/regdocs/searchSDS.do
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Storage and Handling

Store tubes at 2°C–27°C in the foil pouch. Do not freeze the reagent or 
expose it to direct light at any time during storage or incubation with 
cells. The dried fluorochrome-conjugated antibodies are stable until the 
expiration date shown on the pouch and tube labels when stored as 
directed. Do not use after the expiration date. Once the pouch is 
opened, the dried fluorochrome-conjugated antibodies are stable for 
one month when stored as directed.

CAUTION Ensure that the pouch is completely resealed after removing 
a tube. The reagent is very sensitive to moisture. Do not remove the 
desiccant from the reagent pouch.

5. INSTRUMENTS

BD OneFlow™ PCST is for use on the following BD instruments.

Table 2 Recommended BD instruments

Flow cytometer Setup beads Setup software Analysis software

BD FACSLyric™a

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)

BD® CS&T Beads
BD® FC Beads 7-Color 
Kit
BD® FC Beads 5-Color 
Kit

BD FACSuite™ 
Clinical application 
v1.4 or later

BD FACSuite™ 
Clinical application 
v1.4 or later

BD FACSCanto™ IIb

b. 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

BD FACSDiva™ CS&T 
IVD Beads
BD OneFlow™ Setup 
Beads
BD® FC Beads 8-Color 
Kit for BD OneFlow™ 
Assays

BD FACSDiva™ 
software v8.0.1 or 
later

BD FACSDiva™ 
software v8.0.1 or 
later
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The BD FACS™ Universal Loader can be used with this product. See 
the BD FACSLyric™ Clinical System Instructions For Use for more 
information. The Loader can be used with BD FACSuite™ Clinical 
application v1.5 or later.

6. SPECIMENS

BD OneFlow™ PCST can be used for flow-cytometric 
immunophenotyping of BM aspirates collected in EDTA or 
heparin13-19 (for example, in BD Vacutainer® blood collection tubes). 
Store specimens at 15°C–27°C prior to staining. Each type of specimen 
can have different storage conditions and limitations that should be 
considered prior to collection and analysis.13,14,17

Specimens should be processed immediately after collection, or up to 
24 hours after collection if stored at room temperature.15,16,18,19 If a 
longer period of time is needed, each laboratory should validate that 
specimens processed and stored according to their procedures produce 
equivalent results to specimens processed immediately after collection. 

Specimens with large numbers of nonviable cells can give erroneous 
results due to selective loss of populations and to increased nonspecific 
binding of antibodies to nonviable cells. Viability of specimens should 
be assessed and a cutoff value established. A cutoff value of at least 
80% viable cells has been suggested.13

Samples should be acquired within 60 minutes if kept at room 
temperature, protected from light. If a longer period of time is needed, 
each laboratory should validate that stained specimens acquired after 
being held under their storage conditions produce equivalent results to 
specimens acquired immediately after staining. Protect stained 
specimens from light until they are acquired.

WARNING All biological specimens and materials coming in contact 
with them are considered biohazards. Handle as if capable of 
transmitting infection14,15 and dispose of with proper precautions in 
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accordance with federal, state, and local regulations. Never pipette by 
mouth. Wear suitable protective clothing, eyewear, and gloves.

7. REAGENTS AND MATERIALS

Reagents Provided

BD OneFlow™ PCST is provided as single-use tubes in foil pouches. 
Each kit contains four pouches:

• Two pouches, each containing five tubes of BD OneFlow™ 
PCST (S)

• Two pouches, each containing five tubes of BD OneFlow™ 
PCST (C)

Reagents and Materials Required but Not Provided

For BD FACSLyric™ flow cytometers:

• BD OneFlow™ Assays Installer I (Catalog No. 664225)

An installer is required for the BD OneFlow™ PCST assay. If you 
are using the Loader, use BD OneFlow™ Assays Installer I v1.1 to 
install the assay in BD FACSuite™ Clinical application v1.5 or 
later. The assay comprises an acquisition sheet, a laboratory report, 
a physician report, and a supplemental report used for further 
investigation. Unless you already have the current BD OneFlow™ 
PCST assay, you will have to order the installer for BD OneFlow™ 
Assays the first time you order BD OneFlow™ PCST. The installer 
also contains assays for other BD OneFlow™ reagents.

The BD OneFlow™ Application Guide for Plasma Cell Disorders 
for BD FACSLyric™ Flow Cytometers is provided with the 
installer. Application guides for other BD OneFlow™ reagents are 
also included.
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For BD FACSCanto™ II flow cytometers:

• BD OneFlow™ Assay Templates Installer (Catalog No. 659305)

An installer is required for the BD OneFlow™ PCST template. The 
template contains two global worksheets: the BD OneFlow™ 
PCST Acquisition worksheet and the BD OneFlow™ PCST 
Analysis worksheet. Unless you already have the current 
BD OneFlow™ PCST template, you will have to order the installer 
the first time you order BD OneFlow™ PCST. The installer also 
contains the OneFlow Setup template and templates for other 
BD OneFlow™ reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the 
BD OneFlow™ Application Guide for Plasma Cell Disorders are 
provided with the installer. Application guides for other 
BD OneFlow™ reagents are also included.

• 15-mL conical polypropylene tubes
• Pasteur pipet
• Serological pipet
• Micropipettor with tips
• Vortex mixer
• Centrifuge
• Wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium 

azide)
• FIX & PERM® Cell Fixation & Cell Permeabilization kit

For BD FACSLyric™ flow cytometers:

• BD® CS&T Beads (Catalog No. 656504 or 656505)
• BD® FC Beads 7-Color Kit (Catalog No. 656867)
• BD® FC Beads 5-Color Kit (Catalog No. 661564)
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For BD FACSCanto™ II flow cytometers:

• BD FACSDiva™ CS&T IVD Beads (Catalog No. 656046 or 
656047)

• BD OneFlow™ Setup Beads (Catalog No. 658620)
• BD® FC Beads 8-Color Kit for BD OneFlow™ Assays 

(Catalog No. 658621)

8. PROCEDURE

Installing the BD OneFlow™ PCST Assay or Template

The BD OneFlow™ PCST assay, used with BD FACSuite™ Clinical 
application, or the BD OneFlow™ PCST template, used with 
BD FACSDiva™ software, has to be installed before you run the assay 
for the first time. Additional assays or templates can be installed at the 
same time, as needed. If you will analyze the FCS files on a different 
workstation from the one used to acquire the samples, ensure that you 
install the assays or templates on both workstations.

To install the BD OneFlow™ assay in BD FACSuite™ Clinical 
application:

NOTE When you select an assay to install, it will overwrite the 
BD OneFlow™ PCST assay that was previously installed on the 
system. If you do not want an existing assay on your computer to be 
overwritten, do not select that assay from the installer during the 
installation process.

1. Insert the installer and click the installer icon.

The InstallShield Wizard for BD OneFlow™ Assays opens.

2. Click Next.

The license agreement opens.

3. Select the I accept the terms in the license agreement option and 
click Next.
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4. To install all of the assays included on the installer, select the 
Complete option and click Next.

5. Optional: To install a subset of the assays included on the installer, 
select the Custom option and click Next.

The Custom Setup dialog opens.

• Click the menu to the left of the appropriate assay.
• From the menu, select This assay will be installed on your local 

hard drive.

6. Click Install.

The assays will be installed in the Library.

7. Click Finish.

The InstallShield Wizard closes.

8. Optional: Double-click the ReadMe file found on the installer.

The ReadMe file opens.

9. Click the close box when finished reading it.

10. Remove the installer.

To install the BD OneFlow™ template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite 
any template with the same name that was previously installed on the 
system. If you do not want an existing template on your computer to 
be overwritten, do not select that template from the installer during the 
installation process.

Insert the installer and click the installer icon.



15

1. Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder 
D:\BDExport\Templates\Panel\BD Panels.

NOTE If your system has only one drive, the templates will be 
installed in C:\BDExport\Templates\Panel\BD Panels.

After installation is complete, a dialog opens, summarizing which 
templates have been successfully copied into the folder.

2. Click OK to close the dialog.

3. The installer ReadMe file opens. Click the close box when you 
have finished reading it.

4. Remove the installer.

Setting up the Cytometer

For BD FACSLyric™ flow cytometers:

1. Use BD® CS&T Beads and BD FACSuite™ Clinical application 
v1.4 or later, to perform Characterization QC (CQC) every 
6 months or as needed, perform daily Performance QC (PQC), and 
perform daily assay and tube settings setup. For assay and tube 
settings setup, select the Run Setup and Generate Reports 
checkboxes.

2. Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, 
and BD FACSuite™ Clinical application v1.4 or later, to update 
reference settings every 60 days.

See the BD FACSLyric™ Clinical System Instructions For Use, the 
BD FACSLyric™ Clinical Reference System, and the appropriate 
reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:

1. Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and 
BD FACSDiva™ software v8.0.1 or later, to define the baseline of 
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the cytometer and to run a daily performance check of the 
cytometer. 

2. Use BD OneFlow™ Setup Beads, lysed washed blood, and 
BD FACSDiva™ software v8.0.1 or later, to set photomultiplier 
tube (PMT) and scatter voltages monthly. 

3. Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, 
to set fluorescence compensation monthly.

4. We recommend that you confirm that the PMT voltages (PMTVs) 
are still within their daily target ranges.

See the Instrument Setup Guide for BD OneFlow™ Assays and the 
appropriate reagent IFU for more information.

Processing the Specimen

Washing the specimen

NOTE Before washing the specimen, confirm that the cytometer has 
been properly set up.

1. Label a 15-mL conical tube with the specimen ID.

2. Invert the specimen in the collection tube 10 times to mix well.

3. Add 300 µL of the specimen to the labeled conical tube.

4. Add 10 mL of wash buffer (filtered PBS + 0.5% BSA + 0.1% 
sodium azide).

5. Invert the tube 3–5 times to mix well.

6. Centrifuge at 540g for 5 minutes at 20°C–25°C.

7. Remove the supernatant without disturbing the cell pellet.

8. Vortex the tube until no cell aggregates remain before adding wash 
buffer.

9. Repeat steps 4–8 twice for a total of three washes.
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10. Resuspend the cell pellet in 200 µL of wash buffer to give a final 
volume of approximately 300 µL.

11. Vortex vigorously 3–5 seconds to completely resuspend the cell 
pellet.

NOTE Start staining the specimen using the BD OneFlow™ PCST 
tube within 30 minutes of the last wash. Store the washed 
specimen at 20°C–25°C until you stain it.

Staining the specimen

12. If the pouch is stored refrigerated, allow it to reach room 
temperature before opening it.

NOTE The reagent is very sensitive to moisture. To avoid 
condensation, open the pouch only if it is at room temperature.

13. For each patient specimen, remove a BD OneFlow™ PCST (S) tube 
from its pouch and reseal the pouch immediately. Do not remove 
the BD OneFlow™ PCST (C) tube at this time.

14. Place the tubes in a rack, protected from light.

Start staining the specimen within one hour of removing a tube 
from the pouch.

15. Immediately reseal the pouch with any unused tubes.

NOTE Ensure the pouch is completely resealed after removing a 
tube. The reagent is very sensitive to moisture. Do not remove the 
desiccant from the reagent pouch.

16. Write the patient ID on the BD OneFlow™ PCST (S) tube label 
within the area provided.

NOTE Write the current date on the pouch label when it is first 
opened. Use the tubes from that pouch within one month before 
opening the next pouch.

17. Vortex washed specimen 3–5 seconds to mix well.
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18. Add 50 µL of wash buffer and 50 µL of washed specimen to the 
tube. Vortex vigorously 3–5 seconds to mix well.

19. Incubate for 30 minutes at 20°C–25°C in the dark.

20. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

21. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

22. Centrifuge at 540g for 5 minutes at 20°C–25°C.

23. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

24. Vortex vigorously until the cell pellet is completely resuspended.

25. Add 100 µL of FIX & PERM Reagent A (fixation solution) to the 
tube. Vortex vigorously 3–5 seconds to mix well.

26. Incubate for 15 minutes at 20°C–25°C in the dark.

27. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

28. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

29. Centrifuge at 540g for 5 minutes at 20°C–25°C.

30. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

31. Vortex vigorously until the cell pellet is completely resuspended.

NOTE If the you are unable to obtain a single-cell suspension, see 
Troubleshooting.
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32. Measure the volume in each tube using a pipet and add wash 
buffer to give a final volume of 100 µL in each tube. Vortex 3–
5 seconds to mix well.

NOTE It is important to have a final volume of 100 µL in each 
tube so that all of the cells will be completely permeabilized in 
steps 21–23.

33. Remove the appropriate number of BD OneFlow™ PCST (C) 
tubes from the pouch and reseal the pouch immediately.

CAUTION Ensure that the pouch is completely resealed after 
removing a tube. The reagent is very sensitive to moisture. Do not 
remove the desiccant from the reagent pouch.

NOTE Write the patient ID on the BD OneFlow™ PCST (C) tube 
label within the area provided. Write the current date on the pouch 
label when it is first opened. Use the tubes from that pouch within 
one month before opening the next one.

34. Add 100 µL of FIX & PERM Reagent B (permeabilization 
solution) to the BD OneFlow™ PCST (C) tube.

35. Transfer 100 µL of the sample from the BD OneFlow™ PCST (S) 
tube to the corresponding BD OneFlow™ PCST (C) tube.

NOTE Make sure that the patient ID numbers on the two tubes are 
the same.

36. Vortex the BD OneFlow™ PCST (C) tube vigorously 3–5 seconds 
to mix well. 

37. Incubate for 15 minutes at 20°C–25°C in the dark.

38. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix 
well.

39. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.

40. Centrifuge at 540g for 5 minutes at 20°C–25°C.
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41. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

42. Add 200 µL of wash buffer to the tube. Vortex vigorously 3–
5 seconds to completely resuspend the cell pellet.

NOTE Samples should be acquired within 60 minutes if kept at 
room temperature, protected from light. If a longer period of time 
is needed, each laboratory should validate that stained specimens 
acquired after being held under their storage conditions produce 
equivalent results to specimens acquired immediately after 
staining. Protect stained specimens from light until they are 
acquired.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1. From the BD FACSuite™ Clinical application navigation bar, click 
the Library icon.

The Library workspace opens.

2. Expand the Beads and Reagents menu and select Reagents.

3. Select OneFlow PCST from the Product Name list.

The OneFlow PCST pane opens at the bottom of the page.

4. Click Add Lot.

The Add New Lot dialog opens.
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5. In BD FACSuite™ Clinical application v1.5, click Scan Barcode 
and then scan the barcode on the pouch or tube label.

The Lot ID and expiration date are entered in the appropriate 
fields.

Make sure to add the Lot ID and expiration date for both tubes, 
BD OneFlow™ PCST (S) and BD OneFlow™ PCST (C).

NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID 
and expiration date manually.

6. Select the Current Lot checkbox.

7. Click OK.

The lot ID and expiration date are added to the appropriate 
columns for the reagent.

NOTE Make sure to add the reagent lot and expiration date prior 
to acquisition. This has to be done only once for a particular 
reagent lot.

To create a worklist:

1. From the BD FACSuite™ Clinical application navigation bar, click 
the Worklists icon.

The Worklists workspace opens.

2. In the Manage Worklists tab, click New.

A blank worklist opens in a new tab.

3. In the Worklist Entries section, select the appropriate task from the 
Task menu.

4. Enter the Sample ID for BD OneFlow™ reagent tasks.
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Do not scan the barcode, found on the tube label, into the 
software.

NOTE Multiple lots of reagent cannot be run on the same 
worklist.

5. In the Loading Options section, select Manual or Universal Loader 
from the Loading Option menu.

6. If using the Loader, select 30 Tube Rack or 40 Tube Rack from the 
Carrier Type menu.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)

1. From the menu bar, select Edit > User Preferences, then navigate to 
the FCS tab, and select Export FCS after recording, to 
automatically export the FCS files after acquisition. Click OK.

2. Confirm that the cytometer is in the 4-2H-2V BD default 
configuration.

3. From the menu bar, select Experiment > New Experiment > Blank 
Experiment. Click OK.

NOTE You can also create an experiment directly from the 
Browser using the Experiment icon.

4. If prompted by the CST Mismatch dialog, select Use CST Settings.

5. Rename the experiment according to your laboratory practice.

6. In the Browser, right-click Cytometer Settings > Link Setup and 
select the appropriate compensation matrix calculated using 
BD® FC Beads within the past 31 days. Click Link. See the 
BD® FC Beads 8-color kit for BD OneFlow™ Assays IFU or the 
Instrument Setup Guide for BD OneFlow™ Assays.
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7. If prompted by the Cytometer Settings Mismatch dialog, select 
Overwrite.

8. Right-click Cytometer Settings > Unlink From and select the 
previously linked compensation setup. Click OK.

NOTE Unlinking the compensation setup allows updated 
application settings to be applied while retaining compensation 
values.

9. In the Browser, right-click Cytometer Settings > Application 
Settings > Apply and select the most recent application settings 
determined within the last 31 days using the BD OneFlow™ Setup 
Beads. Click Apply.

10. A Confirm dialog opens. Select Keep the compensation value.

11. If prompted by the Confirm Cytometer Changes dialog, click Yes 
to overwrite the cytometer values for FSC Area Scaling.

12. From the menu bar, select Experiment > New Specimen.

The Panel Templates dialog opens.

13. Navigate to the BD Panels tab and select the OneFlow PCST 
template.

NOTE Make sure that you select the template for the tube you are 
acquiring.

14. Indicate the number of patient specimens you want to acquire 
using the Copies field near the bottom of the BD Panels tab. Click 
OK.

15. Rename each specimen, for example, with the appropriate patient 
ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the 
current tube pointer to the tube you wish to re-run. Click Next 
Tube in the Acquisition Dashboard to create another tube for that 
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patient. Do not select Experiment > New Tube from the menu bar 
or use the New Tube icon from the Browser menu bar to create the 
additional tube to be acquired because the labels and barcode 
fields will not be populated.

NOTE If you want to acquire additional patient samples in the 
experiment, repeat steps 12–15 to add new specimens. Two 
Confirm dialogs will open asking if you want to create another 
BD OneFlow™ PCST Acquisition worksheet or another 
BD OneFlow™ PCST Analysis worksheet. Click Cancel in each 
dialog.

16. From the menu bar, select Experiment > Experiment Layout and 
navigate to the Keywords tab.

17. Highlight the Product ID keyword for the appropriate tube, and 
scan the barcode on the BD OneFlow™ PCST (C) tube label.

NOTE If you cannot scan the barcode on the tube label, see 
Troubleshooting.

18. Manually add the appropriate information to the remaining 
keywords, as needed.

19. Click OK to close the Experiment Layout.

Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

Assay version Software Stopping time Acquisition mode

v1.0 BD FACSuite™ Clinical 
application v1.4 or later

5 minutes Manual

v1.1 BD FACSuite™ Clinical 
application v1.5 or later

3 minutes Manual, Loader
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The assay will automatically collect 100,000 total events. You cannot 
append the number of events to collect after acquisition has started. 
Therefore, if needed, change the number of events to collect before you 
start acquisition. To change the number of events to collect, see the 
BD OneFlow™ Application Guide for Plasma Cell Disorders for 
BD FACSLyric™ Flow Cytometers. A clinically relevant number of 
cells can be determined at the discretion of an appropriate healthcare 
professional.

To acquire the sample using BD OneFlow™ PCST assay v1.1:

1. In the Worklist Controls bar, select Run All from the Run menu to 
run the entire worklist from the beginning.

Alternatively, to acquire a specific tube, set the run pointer to the 
sample you want to run and select Run from Pointer from the Run 
menu.

2. Vortex each stained tube 3–5 seconds at low speed immediately 
prior to acquisition.

If using the BD FACS™ Universal Loader, vortex tubes 
immediately before placing them in the Loader racks.

NOTE Make sure that all of the BD OneFlow™ tubes in the rack 
are acquired within 1 hour. If not, you must validate tubes 
acquired outside the 1 hour time.

3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ PCST Acquisition sheet opens. The acquisition 
sheet contains dot plots and gates to identify Leukocytes, 
Lymphocytes, B cells, T cells, NK cells, and their relevant 
subpopulations.
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4. Examine each dot plot on the acquisition sheet.

NOTE  The preview time is 10 seconds and then data is 
automatically recorded. Do not increase the preview time and risk 
loss of the sample due to insufficient volume.

NOTE The assay will automatically collect 100,000 total events. If 
the assay cannot collect 100,000 total events, acquisition will stop 
after 3 minutes. A QC message, “All Events gate does not contain 
the requested 100,000 events” is generated in the Lab Report, and 
can be ignored if the sample can be analyzed using the events 
acquired. 

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

To acquire the sample using BD OneFlow™ PCST assay v1.0:

1. In the Worklist Controls bar, select Run All from the Run menu to 
run the entire worklist from the beginning.

Alternatively, to acquire a specific tube, set the run pointer to the 
sample you want to run and select Run from Pointer from the Run 
menu.

2. Vortex each stained tube 3–5 seconds at low speed immediately 
prior to acquisition.

3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ PCST Acquisition sheet opens. The acquisition 
sheet contains dot plots and gates to identify Cells, CD38+ cells, 
and B cells.

4. Examine each dot plot on the acquisition sheet.

NOTE The preview time is 10 seconds and then data is 
automatically recorded. Do not increase the preview time and risk 
loss of the sample due to insufficient volume.



27

5. If it appears that fewer than 100,000 events will be collected, 
monitor the sample volume and click Stop Tube in the Worklist 
Controls bar to stop acquisition before the tube runs dry.

NOTE The assay will automatically collect 100,000 total events. If 
the assay cannot collect 100,000 total events, acquisition will stop 
after 5 minutes. However, make sure you monitor the sample 
volume and click Stop Tube in the Worklist Controls bar to stop 
acquisition before the tube runs dry. To change the stopping 
criteria, see the BD OneFlow™ Application Guide for Plasma Cell 
Disorders for BD FACSLyric™ Flow Cytometers.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

For BD FACSCanto™ II flow cytometers:

1. Vortex the cells 3–5 seconds at low speed immediately before 
acquiring the tube on the flow cytometer.

2. In the Browser, expand the appropriate specimen and set the 
current tube pointer to that tube.

3. Install the tube on the cytometer. Adjust the flow rate to Medium 
in the Acquisition Dashboard. Click Acquire Data.

4. Verify that the population is on scale and adjust the gate in the first 
plot of the BD OneFlow™ PCST Acquisition worksheet to exclude 
debris, if needed.

5. Click Record Data in the Acquisition Dashboard to collect total 
events.

NOTE The template will automatically collect 100,000 total 
events.2 Use the menu in the Acquisition Dashboard to select a 
different number of events to acquire, if needed. A clinically 
relevant number of cells can be determined at the discretion of an 
appropriate healthcare professional.
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6. Inspect the dot plots on the acquisition worksheet, and adjust the 
gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris may appear compressed. This is a 
consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

The FSC-A vs SSC-A dot plot is used to identify cells.

The CD38 FITC-A vs CD45 V450-A dot plot is used to identify 
CD38+ cells.

The CD19 PE-Cy7-A vs SSC-A dot plot is used to identify B cells.

The dot plots for the remaining markers do not contain gates and 
are included to ensure that the antibodies can stain cells in the 
specimen, therefore serving as an internal quality control for the 
tube.

Examine the cyIgK APC-A vs cyIgL APC-H7-A dot plots to assess 
the clonality of the CD38+ cells and the B cells.

NOTE See the BD OneFlow™ Application Guide for Plasma Cell 
Disorders for examples of the dot plots showing populations of 
normal cells in the acquisition worksheet.

7. Acquire the next sample.

8. From the menu bar, select File > Export > Experiments, and select 
the Directory Export option. Click OK.
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Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ PCST assay v1.0 can 
be opened in BD OneFlow™ PCST assay v1.1.

1. Set the run pointer to the appropriate sample in the Worklist 
Entries panel.

The BD OneFlow™ PCST Laboratory Report opens in the 
Laboratory Report tab.

2. Review the BD OneFlow™ PCST Laboratory Report.

The first page of the laboratory report shows sample and tube 
information, population statistics, and QC messages, if generated.

NOTE Populations with a low number of events might report 
%Parent or %Grandparent as 0.0%. This is due to rounding the 
result to a single decimal place in BD FACSuite™ Clinical 
application.

3. Inspect the dot plots on page 2 of the laboratory report and adjust 
the gates as needed.

The dot plots on page 2 of the laboratory report provide a high 
level cell analysis, identifying Cells, FSC Singlets, SSC Singlets, and 
B cells.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

See the BD OneFlow™ Application Guide for Plasma Cell 
Disorders for BD FACSLyric™ Flow Cytometers for examples of 
dot plots showing populations of normal cells.
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4. Inspect the dot plots on page 3 of the laboratory report and adjust 
the gates as needed.

The dot plots on page 3 of the laboratory report are used to 
analyze the plasma cells in the sample. Dot plots and gates are 
provided to identify CD38+ cells, Plasma cells, cyIgL+, and cyIgK+ 
cells. The remaining dot plots characterize the cyIgL+ and cyIgK+ 
populations.

5. Inspect page 4 of the laboratory report.

Page 4 of the laboratory report includes lot and expiration dates 
for BD® CS&T Beads and the BD OneFlow™ reagent, reference 
settings, tube settings, and cytometer configuration.

6. (Optional) Select the Physician Report tab to view the report.

The BD OneFlow™ PCST Physician Report contains a high level 
summary of the assay results.

7. (Optional) Select the Supplemental Report tab to add additional 
dot plots to further analyze the sample.

See the BD OneFlow™ Application Guide for Plasma Cell 
Disorders for BD FACSLyric™ Flow Cytometers for more 
information.

WARNING Any gated regions deleted in this Supplemental Report 
are reflected in the Laboratory and Physician Reports. Any gated 
regions created in this Supplemental Report might be reflected in 
the Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory 
Report or Physician Report. They cannot be deleted and will 
invalidate the report.

8. Select the Laboratory Report tab.
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9. Click E-sign.

The E-Signature dialog opens.

10. Select a user ID.

11. Type your password.

12. (Optional) Enter any comments.

13. Click Sign.

The dialog closes and the signer’s user ID, date and time, and 
comments are added to the E-signature box in all three reports.

14. Click Approve.

The Laboratory and Physicians Reports are automatically exported 
to C:\BD Export Clinical. If needed, manually export the 
Supplemental Report.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

1. From the menu bar, select File > Import > Experiments.

2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis 
worksheets opens.

3. Select the BD OneFlow™ PCST Analysis worksheet tab.

4. Inspect the dot plots on page 1 of the analysis worksheet, and 
adjust the gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris might appear compressed. This is a 
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consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

The first three dot plots on page 1 of the analysis worksheet 
identify the FSC and SSC singlets. Debris and doublets are 
excluded by adjusting the gates.

The CD38+ cells are identified in the CD38 FITC-A vs CD45 
V450-A dot plot, and then plasma cells are identified in the CD38 
FITC-A vs CD138 V500-A dot plot. The plasma cells are 
subsequently characterized by gating on the cells expressing cyIgκ 
and cyIgλ. These three dot plots are repeated at the top of page 2 
of the PCST analysis worksheet for reference. The CD38 FITC-A 
vs SSC-A dot plot is included for informational purposes to allow 
for the visualization of CD38bright cells.

B cells are identified in the CD19 PE-Cy7-A vs SSC-A dot plot and 
then characterized in the cyIgK APC-A vs cyIgL APC-H7-A dot 
plot.

NOTE See the BD OneFlow™ Application Guide for Plasma Cell 
Disorders for examples of dot plots showing populations of 
normal cells.

5. Inspect the dot plots on page 2 of the analysis worksheet.

The cyIgκ+ plasma cells and cyIgλ+ plasma cells are further 
characterized according to the levels of CD19, CD45, CD56, and 
β2-Microglobulin expression.

6. Examine the results in the statistics box on page 3 of the analysis 
worksheet.

Confirm that all of the keywords are present in the statistics box. If 
any of the keywords are missing, see Troubleshooting.
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7. Perform further analyses as needed.

NOTE The gates provided in the dot plots of the analysis 
worksheet are for normal populations of cells. If your analysis 
shows cell populations which fall outside of the provided gates, 
they might represent aberrant cell populations, and will require 
further analysis.

8. Save the BD OneFlow™ PCST analysis worksheet as a PDF.

NOTE The BD OneFlow™ PCST analysis worksheet is a global 
worksheet. Any gates that are adjusted when analyzing a sample 
on a global worksheet will be changed in previously analyzed files. 
Previously saved PDFs will not change, but if you go back to a 
previously analyzed global worksheet, you will have to readjust the 
gates so they match what they were before.

9. (Optional) Click Print to print the analysis worksheet as a PDF.

10. Analyze the next sample.

9. LIMITATIONS

• Use of therapeutic monoclonal antibodies in patient treatment can 
interfere with recognition of target antigens by this reagent. This 
should be considered when analyzing samples from patients 
treated in this fashion. BD Biosciences has not characterized the 
effect of the presence of therapeutic antibodies on the performance 
of this reagent.

• Diagnostic evaluation of hematologic disorders using this reagent 
should be performed in the context of a thorough 
immunophenotypic analysis including other relevant markers.

• Use of BD OneFlow™ PCST requires experience with leukemia 
and lymphoma immunophenotyping and classification. The results 
should be interpreted by a pathologist, or equivalent professional, 
in conjunction with other clinical or laboratory findings.
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• BD OneFlow™ PCST has not been tested on specimens from 
patients with minimal residual disease (MRD).

• Avoid using potentially compromised specimens, including clotted, 
hemolyzed, frozen, or refrigerated specimens.

10. PERFORMANCE CHARACTERISTICS

BD FACSLyric™ Flow Cytometer

Precision studies for the reproducibility and repeatability of 
BD OneFlow™ PCST were performed at BD Research Centre Ireland.

Reproducibility and repeatability (BD FACSLyric™ flow cytometer)

A 5-day study was performed at one site to assess the reproducibility 
and repeatability of BD OneFlow™ PCST using control material. Two 
sources of control material were used, BD Multi-Check™ Control and 
CD-Chex CD103 Plus®, in order to assess all of the markers 
recognized by the antibodies in BD OneFlow™ PCST. Estimates of 
precision were determined across three BD FACSLyric™ flow 
cytometers and three operators by acquiring the each of the control 
materials stained in duplicate by each operator using three lots of 
BD OneFlow™ PCST. Two separate runs were performed by each 
operator on each of the 5 tested days.

Eight subsets were identified as being a percentage of the cell 
populations indicated in the following tables. The tables present the 
mean, standard deviation (SD), coefficient of variation (%CV), and the 
upper 95% confidence limit (CL) for reproducibility (operator/
instrument-to-operator/instrument, lot-to-lot, run-to-run, and 
day-to-day reproducibility) and repeatability (within-run precision) for 
each subset percentage.
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Method comparison (BD FACSLyric™ flow cytometer)

A method comparison study between the BD OneFlow™ system on the 
BD FACSLyric™ flow cytometer (Investigational Method) and the 
BD OneFlow™ system on the BD FACSCanto™ II flow cytometer 
(Comparator Method) was performed at 4 clinical sites. The 
BD OneFlow™ system on BD FACSLyric™ comprises BD® CS&T 
Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and 
BD OneFlow™ PCST acquired on a 10-color BD FACSLyric™ flow 
cytometer (4-Blue 3-Red 3-Violet) using BD FACSuite™ Clinical 
application v1.3† and the BD OneFlow™ PCST assay. The 
BD OneFlow™ reference system on BD FACSCanto™ II comprises 

Table 3 Reproducibility of subset percentages

Subset Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

CD56+ cells 
(% Lymphocytes)

11.92 0.84 0.95 7.02 7.89

CD19 (% SSC Singlets) 4.56 0.08 0.09 1.78 2

IgK (% B cells) 58.14 1.39 1.59 2.39 2.69

IgL (% B cells) 39.1 1.29 1.47 3.3 3.71

Table 4 Repeatability of subset percentages

Subset Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

CD56+ cells 
(% Lymphocytes)

11.92 0.73 0.83 6.11 6.87

CD19 (% SSC Singlets) 4.56 0.16 0.19 3.58 4.02

IgK (% B cells) 58.14 2.32 2.65 3.98 4.48

IgL (% B cells) 39.1 2.32 2.65 5.93 6.67



36

BD FACSDiva™ CS&T IVD Beads, BD OneFlow™ Setup Beads, 
BD® FC Beads 8-Color Kit for BD OneFlow™ Assays, and 
BD OneFlow™ PCST acquired on a BD FACSCanto™ II flow 
cytometer (4-2H-2V) using BD FACSDiva™ software v8.0.2 and the 
BD OneFlow™ PCST template. A total of 80 evaluable BM specimens 
were enrolled in the study. Specimens were collected in the 
anticoagulants shown. See Table 5.

For all enrolled specimens, the first wash step was started within 
24 hours of collection. All stained samples were acquired within 
45 minutes of final resuspension. For all enrolled specimens, the 
number of plasma cell events and percentages were within the ranges 
shown. See Table 6.

† A regression study was performed, demonstrating equivalence between 
BD FACSuite™ Clinical application v1.3 and v1.4.

Table 5 Anticoagulants used to collect specimens

Specimen type

Anticoagulant

EDTA Heparin

Abnormal plasma cells 41 1

Normal polyclonal plasma cells 35 3

Total 76 4

Table 6 Ranges of plasma cell events and percentages

Plasma cells Range

Number of events 12–38,065

% of SSC Singlets 0–42.4%
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Specimens were identified as “Aberrant plasma cells” or “Normal 
polyclonal plasma cells” using the two systems, and compared.

Agreement was calculated as follows:
Overall % agreement = ((a+d)/(a+b+c+d))×100
Positive % agreement = (a/(a+c))×100
Negative % agreement = (d/(d+b))×100

wherein,
a = number of samples identified as “Aberrant plasma cells” for both systems,
b = number of samples identified as “Aberrant plasma cells” on the BD FACSLyric™ flow 
cytometer but “Normal polyclonal plasma cells” on the BD FACSCanto™ II flow cytometer,
c = number of samples identified as “Normal polyclonal plasma cells” on the BD FACSLyric™ 
flow cytometer but “Aberrant plasma cells” on the BD FACSCanto™ II flow cytometer, 
d = number of samples identified as “Normal polyclonal plasma cells” for both systems.

The results for the identification of specimens as “Aberrant plasma 
cells” or “Normal polyclonal plasma cells” were tabulated. See 
Table 7.

Overall % agreement is 100%. The lower 95% confidence limit is 
96.32%.

Table 7 Agreement for specimens identified as “Aberrant plasma cells” or 
“Normal polyclonal plasma cells”

Comparator method 
(BD FACSCanto II)

Aberrant 
plasma cells

Normal 
polyclonal 

plasma cells

Total

Investigational 
method 
(BD FACSLyric)

Aberrant 
plasma cells

42 0 42

Normal 
polyclonal 
plasma cells

0 38 38

Total 42 38 80
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Positive agreement for “Aberrant plasma cells” is 100%. Negative 
agreement for “Normal polyclonal plasma cells” is 100%.

Equivalency (BD FACSLyric™ flow cytometer)

A quantitative assessment of the cell populations being a percentage of 
the indicated cell population was performed for each evaluable 
specimen enrolled in the method comparison study. Specimens were 
analyzed using the BD OneFlow™ system on the BD FACSLyric™ flow 
cytometer and the BD FACSCanto™ II flow cytometer as described 
previously.

The mean bias for each cell population being a percentage of the 
indicated population on the BD FACSLyric™ flow cytometer versus the 
BD FACSCanto™ II flow cytometer was calculated for all evaluable 
specimens. See Table 8.

The results of the method comparison and equivalency studies indicate 
that the two systems are substantially equivalent.

BD FACSCanto™ II Flow Cytometer

Precision studies for the reproducibility and repeatability of 
BD OneFlow™ PCST were performed at BD Biosciences laboratories 
in San Jose, CA, USA.

Table 8 Summary of mean bias for subset percentages

Population
No. of 

specimensa

a. Some specimens might have been excluded to a low number of events acquired.

Mean bias

Lower 95% 
CL of mean 

bias

Upper 95% 
CL of mean 

bias

Plasma cells (%SSC singlets) 80 –0.04 –0.14 0.06

cyIgKappa (%Plasma cells) 80 –2.03 –3.37 –0.69

cyIgLambda (%Plasma cells) 80 –0.55 –1.71 0.62
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Reproducibility (BD FACSCanto™ II flow cytometer)

Two operators performed two separate runs per day over a period of 
eight days, alternating the runs on two BD FACSCanto™ II flow 
cytometers. The reproducibility of CD38, CD56, β2-Microglobulin, 
CD19, Anti-Kappa, Anti-Lambda, and CD45 was assessed using 
BD Multi-Check™ Control. The reproducibility of CD138 was 
assessed using BM. For each run, duplicate samples of the appropriate 
control (BD Multi-Check™ Control or BM) were stained using three 
lots of BD OneFlow™ PCST by each operator, acquired using the 
BD OneFlow™ PCST Acquisition worksheet, and analyzed using 
BD FACSDiva™ software. Cell populations staining positively for 
CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa, Anti-Lambda, 
and CD45 were identified as being a percentage of the parent 
population (Subset %P). CD138+ cells were identified as being a 
percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. 
The overall reproducibility of Subset %P was calculated for each of the 
antibodies. The overall reproducibility comprises four components: 
operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and 
day-to-day reproducibility. See Table 9.

Table 9 Reproducibility of Subset %P

Population DFa

a. DF = Degrees of Freedom

SDb %CVc UCLd

CD56+ 95 1.45 11.2 12.56

β2-Microglobulin+ 95 0.15 0.15 0.17

CD19+ 95 0.49 3.27 3.66

cyIgκ+ 95 0.97 1.73 1.94

cyIgλ+ 95 0.73 1.86 2.08

CD45+ 95 1.14 1.19 1.33

CD38+ 95 1.23 11.81 13.24
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The overall reproducibility of Subset %CD38bright comprises the first 
three components described above and donor-to-donor reproducibility. 
See Table 10.

Repeatability (BD FACSCanto™ II flow cytometer)

Two operators performed two separate runs per day over a period of 
eight days, alternating the runs on two BD FACSCanto™ II flow 
cytometers. The repeatability of CD38, CD56, β2-Microglobulin, 
CD19, Anti-Kappa, Anti-Lambda, and CD45 was assessed using 
BD Multi-Check™ Control. The repeatability of CD138 was assessed 
using BM. For each run, duplicate samples of the appropriate control 
(BD Multi-Check™ Control or BM) were stained using three lots of 
BD OneFlow™ PCST by each operator, acquired using the 
BD OneFlow™ PCST Acquisition worksheet, and analyzed using 
BD FACSDiva™ software. Cell populations staining positively for 
CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa, Anti-Lambda, 
and CD45 were identified as being a percentage of the parent 
population (Subset %P). CD138+ cells were identified as being a 
percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. 
The intra-assay precision (tube-to-tube repeatability) of Subset %P was 
calculated for each of the antibodies. See Table 11.

b. SD = Standard Deviation
c. %CV = % Coefficient of variation
d. UCL = Upper confidence limit of the 95% confidence interval

Table 10 Reproducibility of Subset %CD38bright

Population DF SD %CV UCL

CD138+ 88 7.53 13.58 15.30
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The tube-to-tube repeatability of Subset %CD38bright for CD138 was 
calculated. See Table 12.

Agreement (BD FACSCanto™ II flow cytometer)

A side-by-side comparison study between the BD OneFlow™ PCST 
system on the BD FACSCanto™ II flow cytometer and the 
EuroFlow PCST system on the BD FACSCanto™ II flow cytometer 
was performed. 48 BM samples were collected at 2 external clinical 
sites. The BD OneFlow™ PCST system comprises BD OneFlow™ 
Setup Beads, BD® FC Beads for compensation, and the BD OneFlow™ 
PCST reagent. The EuroFlow PCST reference system comprises 
Sphero™ Rainbow calibration particles (8 peaks), single color stained 
cells plus BD® CompBead particles for compensation, and the 
EuroFlow PCST reagent cocktail. 48 BM samples were identified as 

Table 11 Repeatability of Subset %P

Population DF SD %CV UCL

CD56+ 96 0.33 2.56 2.87

β2-Microglobulin+ 96 0.08 0.08 0.09

CD19+ 96 0.28 1.84 2.05

cyIgκ+ 96 0.87 1.55 1.74

cyIgλ+ 96 0.82 2.08 2.33

CD45+ 96 0.26 0.27 0.30

CD38+ 96 0.24 2.34 2.62

Table 12 Repeatability of Subset %CD38bright

Population DF SD %CV UCL

CD138+ 96 2.85 5.13 5.75
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being “Follow-up needed” or “No follow-up needed” using the two 
systems, and compared. Samples identified as “Follow-up needed” 
were further classified as belonging to the plasma cell lineage or 
another lineage.

Agreement was calculated as follows:
Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,
a = number of samples “Follow-up needed” for both systems,
b = number of samples ”Follow-up needed” for the BD OneFlow™ system but “No follow-up 
needed” for the EuroFlow system,
c = number of samples “No follow-up needed” for the BD OneFlow™ system but “Follow-up 
needed” for the Euroflow system, and
d = number of samples “No follow-up needed” for both systems.

The results for the identification of cells as being “Follow-up needed” 
or “No follow-up needed” were tabulated. See Table 13.

Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% 
agreement.

Table 13 Agreement for cells being “Follow-up Needed” or “No follow-up 
needed”

Comparator method (Euroflow 
PCST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ 
PCST)

Follow-up 
needed

29 0 29

No follow-up 
needed

0 19 19

Total 29 19 48
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The results for samples requiring follow-up for the plasma cell lineage 
or not requiring follow-up for the plasma cell lineage were tabulated. 
See Table 14.

Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% 
agreement.

The results for samples requiring follow-up for a non-plasma cell 
lineage (other lineage) or not requiring follow-up for a non-plasma cell 
lineage (other lineage) were tabulated. See Table 15.

Table 14 Agreement for samples requiring follow-up for the plasma cell lineage or 
not requiring follow-up for the plasma cell lineage

Comparator method (Euroflow 
PCST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ 
PCST)

Follow-up 
needed

22 0 22

No follow-up 
needed

0 26 26

Total 22 26 48

Table 15 Agreement for samples requiring follow-up for a non-plasma cell lineage 
(other lineage) or not requiring follow-up for a non-plasma cell lineage (other 

lineage)

Comparator method (Euroflow 
PCST cocktail)

Follow-up 
needed

No follow-up 
needed

Total
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Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% 
agreement.

Equivalency (BD FACSCanto™ II flow cytometer)

Bone marrow specimens collected at 2 external clinical laboratories 
were obtained from patients with plasma cell disorders, with other 
hematological disorders, or with no hematological abnormalities. 
Specimens were analyzed side-by-side using the BD OneFlow™ PCST 
system and the EuroFlow PCST system described previously. Plasma 
cells (CD45+, CD38+, CD138+) were identified as being a percentage of 
the SSC singlets. cyIgκ+ cells (CD45+, CD38+, CD138+, cyIgκ+, cyIgλ–) 
and cyIgλ+ cells (CD45+, CD38+, CD138+, cyIgλ+, cyIgκ–) were 
identified as being a percentage of plasma cells. Deming regression 
statistics indicate that the results obtained using the two systems are 
substantially equivalent. See Table 16.

Investigational 
method 
(BD OneFlow™ 
PCST)

Follow-up 
needed

7 0 7

No follow-up 
needed

0 41 41

Total 7 41 48

Table 16 Equivalency of the BD OneFlow™ system to the EuroFlow system

Marker
Sample 

size Intercept Slope
Lower 95% 
CLa of slope

Upper 95% 
CL of slope

Plasma cells (%SSC) 48 –0.21 0.95 0.70 1.06

Table 15 Agreement for samples requiring follow-up for a non-plasma cell lineage 
(other lineage) or not requiring follow-up for a non-plasma cell lineage (other 

lineage)

Comparator method (Euroflow 
PCST cocktail)
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11. TROUBLESHOOTING

Problems with cell preparation or staining

cyIgκ+ cells (%plasma 
cells)

46 5.85 0.97 0.85 1.04

cyIgλ+ cells (%plasma 
cells)

46 3.79 0.95 0.89 1.01

a. CL = Confidence Limit

Problem Possible Cause Solution

The resolution between 
debris and cells is poor.

Specimen was over-
permeabilized.

Repeat staining. Incubate the tube in 
FIX & PERM Reagent B for 
15 minutes only.

Specimen is of poor quality. Check cell viability.

Specimen is too old. Obtain a new specimen and stain it 
immediately.

The cytoplasmic 
staining (Igκ and Igλ) is 
dim.

The cells were not 
completely permeabilized.

Repeat staining. Carefully measure 
the specimen volumes in the cell 
fixation and permeabilization steps 
such that the ratio of fixed sample to 
FIX & PERM Reagent B is 1:1.

Cells clump after being 
fixed.

Cells were not completely 
resuspended before fixing 
them.

Vortex tubes until no cell aggregates 
remain before adding FIX & PERM 
Reagent A.

Cells were not thoroughly 
washed after fixing them.

Incubate the tubes for 2 minutes in 
the dark in wash buffer after they 
have been fixed using FIX & PERM 
Reagent A.

Table 16 Equivalency of the BD OneFlow™ system to the EuroFlow system

Marker
Sample 

size Intercept Slope
Lower 95% 
CLa of slope

Upper 95% 
CL of slope
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Problems using BD OneFlow PCST on BD FACSLyric flow cytometers:

Staining is dim or 
fading.

Cell concentration was too 
high at the staining step.

Check the cell concentration and 
adjust as needed.

Washed specimen was not 
stained within 30 minutes of 
the last wash.

Repeat staining with a freshly 
prepared specimen.

The BD OneFlow™ PCST 
tube was exposed to light for 
too long.

Repeat staining with a new tube of 
BD OneFlow™ PCST.

Cells were not acquired 
within 1 hour of staining.

Repeat staining with fresh specimen. 
Acquire promptly.

Few or no cells are 
recorded.

Cell concentration was too 
low.

Resuspend fresh specimen at a 
higher concentration. Repeat 
staining and acquisition.

Cytometer is malfunctioning. Troubleshoot the instrument. See the 
cytometer instructions for use for 
more information.

Problem Possible Cause Solution

Not enough cells of 
interest are acquired.

Cell concentration was too 
low.

Resuspend fresh specimen at a higher 
concentration. Repeat staining and 
acquisition.

The default setting of 
100,000 events acquired is 
too low.

Change the number of events 
acquired. Repeat staining and 
acquisition. See the BD OneFlow™™ 
Application Guide for Plasma Cell 
Disorders for BD FACSLyric™ Flow 
Cytometers.

The FSC-A vs SSC-A 
dot plot is abnormal.

Cytometer needs adjusting. Contact BD Biosciences.

Problem Possible Cause Solution
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Problems using BD OneFlow™ PCST on BD FACSCanto™ II flow cytometers:

The csv file and report 
are not exported 
automatically.

The reagent lot number and 
expiration date were not 
added to the Library.

1. Add the reagent lot number and 
expiration date to the Library.

2. Export the csv file and the report 
PDF manually. See the 
BD FACSLyric™ Clinical System 
Instructions For Use.

Problem Possible Cause Solution

The resolution 
between debris and 
cells is poor.

Instrument settings are 
inappropriate.

Follow proper instrument setup 
procedures. See the Instrument Setup 
Guide for BD OneFlow™ Assays.

Some of the dot plots 
are dimmed.

FSC-H and SSC-H were not 
selected when the 
application settings were 
created.

Check that FSC-H and SSC-H are 
selected on the Parameters tab of the 
Inspector.

The barcode on the 
BD OneFlow™ 
PCST (C) tube label 
cannot be scanned.

The barcode on the tube 
label has been compromised.

Scan the barcode on the 
BD OneFlow™ PCST (C) pouch label 
into the Product ID keyword field in 
the Experiment Layout. Next, 
manually enter a semicolon (;) 
followed by the six-digit tube-specific 
ID, found adjacent to the barcode on 
the tube label, after the last digit of 
the barcode.

The dot plots on the 
worksheets are 
missing or the dot 
plots do not have 
gates.

The template did not import 
correctly.

1. Close the current experiment.

2. Create a new experiment.

3. Re-import the OneFlow™ PCST 
template.

Problem Possible Cause Solution
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WARRANTY

Unless otherwise indicated in any applicable BD general conditions of sale for 
non-US customers, the following warranty applies to the purchase of these 
products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE 
QUANTITY AND CONTENTS STATED ON THE LABEL OR IN THE PRODUCT LABELING 
AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER 
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND 
NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF 
THE PRODUCTS OR REFUND OF THE PURCHASE PRICE. BD IS NOT LIABLE FOR 
PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
INCLUDING PERSONAL INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT. 

Some of the keywords 
are missing from the 
statistics box in the 
analysis worksheet.

BD FACSDiva™ software 
did not import all of the 
keywords into the panel 
template.

1. In the Browser, set the current 
tube pointer to the tube that you 
are analyzing.

2. Navigate to the analysis 
worksheet.

3. Right-click the statistics box and 
select Edit Stats View.

4. In the Header tab, select the All 
checkbox.

5. Click OK.

The statement, For in 
vitro diagnostic use, 
does not appear in the 
footer of the analysis 
worksheet when it is 
printed.

The paper margins in the 
printer settings were 
changed.

1. From the BD FACSDiva™ 
software menu bar, select File > 
Page Setup.

2. Ensure that all of the margins are 
set to 2.54 cm or 1 inch, 
depending on your default 
standards.

3. Click OK.

Problem Possible Cause Solution
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TRADEMARKS

BD, the BD Logo, FACS, FACSCanto, FACSDiva, FACSLyric, 
FACSuite, Horizon, OneFlow and Vacutainer are trademarks of 
Becton, Dickinson and Company or its affiliates. All other trademarks 
are the property of their respective owners. © 2021 BD. All rights 
reserved.
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HISTORY

Revision Date Change made

23-16816-00 2/2016 Initial release

23-16816-01 5/2020 Revised to support using the product on 
BD FACSLyric flow cytometers.

23-16816-02 1/2021 Revised to support using the product with the 
BD FACS™ Universal Loader.
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CONTACT INFORMATION

Becton, Dickinson and Company
BD Biosciences
2350 Qume Drive
San Jose, CA 95131 USA

Benex Limited
Pottery Road, Dun Laoghaire
Co. Dublin, Ireland
Tel +353.1.202.5222
Fax +353.1.202.5388

BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

Australian and New Zealand
Distributors:

Becton Dickinson Pty Ltd.
66 Waterloo Rd
Macquarie Park NSW 2113
Australia

Becton Dickinson Limited
14B George Bourke Drive 
Mt Wellington, Auckland 1060
New Zealand

For technical support, contact: 

bdbiosciences.com
ClinicalApplications@bd.com
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